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1   Introduction
Thank you for choosing HAN, the software suite that revolutionizes distri-
bution of access to Internet resources. This manual gives you step-by-step 
instructions on installing and configuring the components you need, and ex-
plains both how HAN works and how you can work with HAN. 

Terms frequently used in this manual that have a special meaning in the con-
text of HAN are listed together with their definitions in the HAN glossary. A 
PDF version of the HAN manual is available on the installation CD-ROM. You 
can use the search function in the Adobe Reader (version 3 or later) to find 
specific terms in the PDF file.

1.1   Support 
If you have questions regarding support, please contact your software ven-
dor.
You can send technical questions about HAN software to the following e-mail 
address:
supportHAN@hh-software.com

Before you contact your software vendor, please read the relevant sections 
of the manual and refer to the online Help in the HAN program; if you are 
not sure where to look, check the Help index. If you still need help, please 
provide the following information when you send us your question, or have it 
on hand when you call your software vendor:

• The text of any error messages, as well as any relevant data from the 
H+H Trace Monitor

• The steps required to reproduce the problem

1.2   Ideas and Suggestions
We are always happy to hear your ideas, comments and suggestions for 
improvements.
Please send them to: 
H+H Software GmbH
Attn.: HAN Product Manager
Maschmühlenweg 8-10
37073 Göttingen
Germany

Or send e-mail to:
supportHAN@hh-software.com; subject: „HAN“
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1.3   Document Conventions 
The following conventions are observed in this manual: 

Important notes about the HAN software or regarding the use of this 
manual are marked by an exclamation point.

A light bulb indicates tips on how to simplify tasks or prevent prob-
lems before they can occur.

This symbol marks passages that explain a particular term or give 
detailed information or background concerning a certain topic.

The following variables are used as placeholders for certain paths: 

%HANHome% – 
Path to your HAN directory; for example, C:\Program Files\HAN2\WebSrv\
hh\han

%ApacheHome% – 
Path to your Apache installation; for example, C:\Program Files\HAN2\Web-
Srv 

Text used in examples that is meant to be replaced with data provided by 
your HAN environment is displayed in angle brackets ( “<” and “>”).
 
Example:
<HAN server>:   Name of your HAN server
<path to temp directory>:  Path to your Temp directory; e.g., C:\Temp
<HAN ID>:   ID of a particular HAN account

Introduction
Support 

Ideas and Suggestions
Document Conventions 
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1.4   New Features in HAN 2.3
Version 2.3 of HAN has a number of significant improvements in several 
areas. This chapter begins with a list of the new features, and then describes 
them in detail.

• Microsoft Windows Server 2008: The HAN 2.3 setup program supports 
Microsoft’s user account control feature, and sets up the corresponding 
user privileges in the HAN installation directory for the “HAN Administra-
tors” group.

• Protection from botnets: HAN 2.3 has a new mechanism specifically to 
provide protection from botnet attacks.

• Login: When a login operation fails, the login page now shows a mes-
sage informing the user of this fact. 

• Disk space monitoring: The new HAN version monitors the amount of 
space available on the hard drive of the HAN server. In the HAN Settings 
program, you can define two values indicating critically low disk space. 
When the first value is reached, an e-mail informs the administrator that 
available disk space is low. When the second value is reached, any fur-
ther initial request for a HAN account is answered with an error message 
indicating that the system is not available.

• EZB data logging: In HAN 2.3 you can determine whether the data log-
ging function is enabled for EZB updates. One log file is created per day. 

• Statistics data logging: A new mechanism prevents logging of group 
data without group IDs. If the data logging function has been activated 
but no ID explicitly assigned for a group, the group name is automatically 
used as the ID for that group. Settings for group data logging are con-
figured on the “Account/Group Defaults” page of the HAN Administration 
settings program. 

• HAN Web Service Settings: The new HAN version adds a Web Ser-
vice Settings program to the Windows Control Panel. This configuration 
program makes it easier to configure and control the HAN web server, 
provides access to error and usage logs, and facilitates certificate man-
agement.
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Activating/deactivating EZB data logging:

With the default settings, EZB data logging is active. If you do not 
want to log EZB data, this function must be deactivated. One log file 
is created per day. These log files are stored in \HAN2\WebSrv\
hh\han\EZBLogs.

To deactivate EZB data logging, begin by opening the HAN Administration 
settings.

Select the Import from EZB page.

Under Keep a log of imports, click in the box next to Yes to remove the 
checkmark:
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Configuring the disk space monitoring functions:

Open the HAN Settings program.

Open the Disk Space Monitoring page:

Send warning at. When the available disk space drops below this level, an 
e-mail warning is sent to the administrator. The warning is repeated every 
1000 access attempts.
Stop HAN at. When this level is reached, new access requests are blocked. 
Any further attempt to access HAN results in an error message.
HAN error page. The page specified here is opened when the available disk 
space drops below the second value (“Stop HAN at”). Error pages are stored 
in \HAN2\WebSrv\hh\han\hanerror. You can adapt the error pages 
stored here, or add your own. 
SMTP server. The SMTP server used to send the warning e-mail. 
Port. Port for the SMTP server.
Sender. Enter an e-mail address here for use as the sender address of the 
warning e-mail. 
Recipient. Enter the e-mail address of the recipient of the warning e-mail.

Do not enter any values lower than the default values given, as 
these are the absolute minimum disk space amounts required for a 
stable HAN system.
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HAN Web Service Settings:
Select HAN Web Service configuration in the Windows Control Panel to 
open the HAN Web Service Settings program:

The settings configured here are distributed over several dialog pages:

Service
This page shows information on the web server’s status. The Start, Stop and 
Stop and start buttons let you start and stop the web service. Click on the 
Error log or Access log button to open the corresponding log files. Click on 
the Delete log button to delete the log files.

Certificates
This dialog page shows the certificate currently in use. Click on Manage cer-
tificates... to launch a wizard for creating a self-signed (temporary) certificate 
or to import an official certificate.

Configuration
On this page, you can configure the HTTP and HTTPS ports in HAN and 
specify the IP address HAN listens on. 

About
This page shows information about the Settings program.

Creating a self-signed certificate:

Launch the HAN Web Service Settings program from the Windows Control 
Panel and open the “Certificates” page. Click on Manage certificates... to 
run the wizard for managing certificates.
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Select the Create or request a new server certificate task and click on 
Next. Enter data in the Create new server certificate dialog as required:

Server FQDN. The fully qualified domain name of the server on which you 
have installed HAN. The entered here must match the name under which 
server is reached over the Internet. If the server name is han, for example, 
the FQDN might be www.han.com.

Do not use an alias from your intranet as FQDN to request certifi-
cates, as the resulting certificate would not be valid.

Name of the company. The name of your company or organization.
Name of the department. You can use this field to specify a particular de-
partment or section of your company or organization (for example, the data 
processing center).
City. The city in which your organization is located.
State. The state in which your organization is located. 
Country code. Enter the two-letter code for your country (see ISO 3166; 
for example, US for the United States, UK for the United Kingdom, DE for 
Germany, etc.).
E-mail address. The e-mail address for contacting your company. 

Click on Next to continue. In the next dialog, you can specify whether you 
wish to create a self-signed certificate or a certificate request for an official 
certificate authority. Select Issue a self-signed certificate under Type of 
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Certificate, enter the date for the period of validity, and enter a password for 
the private key.

Click on Finish to create the certificate and integrate it in the web server. 
Your changes will not take effect until after you restart the HAN web server.

The HAN Web Service Settings program does not currently support 
certificate chaining. If you want to use a chain of certificates, it must 
be configured manually. To do this, navigate to \HAN2\WebSrv\
hh\han\bin and open the han.cfg file. In the [SSL] section, 
remove the comment tag from the SSLCertificateChainFile 
entry and add the desired file name:

001 [SSL]
002	 #Server	Certificate	Chain:
003	 #Point	SSLCertificateChainFile	at	a	file	

containing the
004	 #concatenation	of	PEM	encoded	CA	certificates	

which form the
005	 #certificate	chain	for	the	server	certificate.	

Alternatively
006	 #the	referenced	file	can	be	the	same	as	

SSLCertificateFile
007	 #when	the	CA	certificates	are	directly	appended	

to the server
008	 #certificate	for	convenience.
009	 SSLCertificateChainFile	conf/ssl.crt/ca.crt
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Requesting and importing official certificates:
Using an official server certificate involves two steps:
1. Request a certificate: A certificate request must be created and sent to a 

certificate authority. The certificate authority checks the specifications of 
the request for correctness and issues the certificate.

2. Import the certificate: Once the certificate has been issued by the certifi-
cate authority, it must be imported to your server.

Requesting a certificate:

In the HAN Web Server Settings dialog, click on Manage certificates... to 
open the certificate management wizard.

Select the Create or request a new server certificate task and click on 
Next. Enter data in the Create a New Server Certificate dialog as required.

Click on Next to continue. In the next dialog, select Create a certificate 
request for an official certificate authority under Type of Certificate and 
enter a password for the private key:
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Click on Finish to create and view the certificate request. To submit the cer-
tificate request to your certificate authority, you can copy and paste it into the 
web form at the CA website, or send a file containing the certificate request 
(by e-mail, for example). This completes the certificate request. When you 
receive the certificate from the certificate authority, proceed with the import 
procedure as follows.

Import the certificate:

In the HAN Web Service Settings dialog, click on Manage certificates... to 
open the certificate management wizard. Select the Import a server certifi-
cate task and click on Next to continue:

In the next dialog, enter the file name of the certificate and the password for 
the private key:
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The Alternative file with the private key (.key) setting is not relevant unless 
the certificate file and private key were both created using other tools, rather 
than using the HAN wizard for creating the certificate request.

The HAN system uses the DER format for certificate files, requests 
and private keys. 

Click on Finish to create the certificate and integrate it in the web server. 
Your changes will not take effect until after you restart the HAN web server.



Hidden Automatic Navigator  |  Manual

12

2   Basic Principles



13

2   Basic Principles

2   Basic Principles

2.1   HAN as Reverse Proxy
Among the variety of functions that can be carried out by a proxy server (such 
as caching web pages), the functionality of a reverse proxy is most relevant 
in conjunction with HAN. 

When a client requests content from the web server of an online 
content provider (also referred to as the origin server), the request 
is recevied by the reverse proxy, which communicates with the 
origin server and then passes its response (for example, the re-
quested content) back to the client. In other words, the client com-
municates only with the reverse proxy, not with the origin server. 
The reverse proxy receives the requested content directly from the 
origin server and delivers it to the browser as though it had origi-
nated with the reverse proxy.

Your HAN server provides URLs (http://<HAN server>/han/<HAN ID>) for 
each e-journal you make available to your users. To access a particular e-
journal, the user simply enters the corresponding HAN-URL in the browser 
address line. The HAN server then initiates communication with the content 
provider and executes any associated scripts; for example, to log in on the 
origin server. Once the re-
source has been located, 
the requested page is deliv-
ered by HAN to the user. 

Thus HAN is a reverse 
proxy in the sense of the 
definition given above, be-
cause clients communicate 
only with the HAN server, 
not with the provider of the 
requested online resources. 

The following diagrams illustrate this process.
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The user calls an online resource.

HAN checks whether the user has permission to access this resource.

If the user does not have the required permissions, a login page opens (or, 
depending on your configurations, an error message is shown).

HAN opens the home page indicated in the HAN account and, if the associ-
ated access script so defines, logs in on the content provider.

HAN delivers the target page to the user.
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This method has the following advantages:

• Fixed point of access for e-journals: Independent of a web site’s URL, 
the URL used to call the e-journal from its site remains constant and can 
be permanently stored; for example, in a library’s OPAC system.

• Access control: Every time a user calls a HAN-URL, the HAN server 
can determine whether that user has permission to access the requested 
resource (see also section 2.2, Authentication and Authorization in HAN).

• Metering: Every time a user calls a HAN-URL, HAN can store statistical 
data regarding the usage of that account (see also section 2.3, Statis-
tics).

• License control: HAN can monitor and control parallel usage of online 
resources.

• Help desk features: You can configure HAN to open an HTML page of 
your choice in the event of error; for example, to provide an explanation 
or background information (e.g., “Login failed” or “No license available”).

• Protection of login data: Login on and communication with the content 
provider involve only HAN and the origin server - not the HAN user. Login 
data and other sensitive information is not shown to users. 

• Location independence: If the requested content is served only to local 
computers (identified by IP address; for example, in a campus licensing 
scheme), you can use a masking IP address so that HAN can serve the 
desired content to your users regardless of their location.

• No modifications on the client: Use of HAN resources is independent 
of the client’s operating system. HAN is suitable for use even in heavily 
regulated environments, since no installation or component configuration 
is required on the client side.

2.2   Authentication and Authorization in HAN
When a HAN resource is called, HAN can check whether the user has the 
permissions required for access to the requested content. In this process, 
an important distinction is made between authentication and authorization.

Authentication is part of the login process; the system addressed 
determines the user’s identity and checks it for authenticity.

Authorization, on the other hand, describes the allocation of per-
missions and privileges to a user.

HAN supports the authentication of individual users and permits an adminis-
trator to restrict or permit access to resources on the basis of user privileges. 
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This can be done on two levels: 

a) Define which users can access HAN (authentication)

b) Define which HAN resources a given user is permitted to call (authoriza-
tion)

HAN supports the use of existing user management tools and settings for 
authentication. Because uncomplicated administration was one of the main 
objectives in developing the software, HAN is made to leverage existing con-
figurations for user authentication, such as ADS and OPAC settings. This 
saves time and effort that would otherwise be spent configuring settings that 
already exist (see also section 3.2, Configuring Authentication Services).

2.3   Statistics
HAN can collect statistical data on every user access operation, which means 
you can analyze all usage data pertaining to your online resources. 
In addition to analysis of the total usage, HAN gives you the option of evalu-
ating parallel use of e-journals and online databases. The results can help 
you determine the optimum number of concurrent-use licenses for e-journal 
subscriptions. 
Furthermore, HAN can run web-counter-compatible evaluations on use sta-
tistics. 
For more details on the topic of statistics in HAN, see chapter 7, Event Log-
ging and Statistical Analysis.
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3.1   Setting up HAN Version 2
System requirements:

• Windows® Server 2003, Windows® Server 2008
• Microsoft Internet Explorer® (version 6 or later)
• At least 10 GB disk space

The HAN setup program installs the following components:

• Apache 2.0.59
• HAN components
• SQLite
• PHP version 5.2.6 (if the “A-Z List” component is selected)

The HAN update feature updates the integrated Apache and PHP 
installations.

For administration of the HAN suite, a good working knowledge of the follow-
ing is recommended: 

• HTML
• HTTP and HTTPS
• Networks

Follow the instructions given by the installation wizard to install HAN. 

A valid serial number must be entered during installation. To obtain 
a serial number, please contact your software vendor.

You can modify or add to the installed components at any time.

When installing HAN on Windows Server 2008, keep in mind that 
with the default settings, Microsoft restricts user privileges in the 
%ProgramFiles% directory.
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Following installation, you need to register your HAN program as described 
below.

The number of concurrent-use licenses to be registered is defined 
when you order the software.

To open the registration wizard, open the Windows Start menu and select 
Programs/HAN/HAN Registration Wizard:

Call your software vendor to obtain the registration code. The following infor-
mation is required for registration:

• Your registration data (your name and company name)
• HAN serial number (on the invoice)
• Identification number (generated automatically by the registration wizard)

Enter the registration code in the License code field and click on Next. The 
next window shows the number of licenses registered. 
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You need to enter the new registration code obtained with your 
HAN 2.x software. The registration wizard does not accept registra-
tion codes from HAN 1 versions.

Your registration is not effective until after you restart the Apache 
service.

Once the installation has been completed, you can configure the global set-
tings in HAN. To open the HAN Settings program, select Programs/HAN/
HAN Settings from the Windows Start menu.

The Settings program has four dialog pages:

• Global
• Proxy 
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• Authentication
• IP Ranges/Host Names

For details on the Authentication and IP Ranges/Host Names pag-
es, see section 3.2, Configuring Authentication Services.

Global
The settings on the Global page define the HAN help desk feature. Here you 
can specify which HTML pages are opened in response to certain events; 
for example, to provide the user with background information or instructions.

You can specify pages for the following events:

• Insufficient access permissions:
• This is the case when a user is not authorized to access the requested 

HAN resource. Depending on which of the following two HTML pages 
you select, the user is either informed that access is not permitted or is 
presented with a login page:

• noaccess.html
• newLogin.html. In this case, the user has the option of entering dif-

ferent authentication data. 

Settings you configure for specific access privileges override the 
global settings configured here (see section 3.3, Permissions).

• Account not found: This page is opened if the account that a HAN-URL 
points to does not exist.

• No license available for the requested HAN account: The HAN program 
lets you restrict parallel usage of HAN accounts by allocating licenses. If 
the number of instances allowed for a requested HAN account is already 
in use, this page is opened. 

• No HAN license available: If all of your HAN user licenses are in use when 
another user requests a HAN resource, this error message is shown.

• To obtain additional user licenses, please contact your software vendor. 

Open the Help menu and select “About” in HAN Administration to 
see how many HAN licenses are currently in use in your system 
(see section 3.2, Licensing).

• EJL error: This error message is shown when an error occurs while cre-
ating a HAN account from the EJL pages (see also chapter 6, EJL and 
HAN).

This option is available only if the EJL module is installed.



21

3   Installation and Configuration

These HTML files are stored in \hh\apache2\hh\han\haner-
ror. You can add new files and edit existing files as desired. The 
selection lists for HTML files show all HTML files stored in this di-
rectory.

The Language setting lets you specify the language used in HAN’s adminis-
trative components. You can choose between German and English. 
The Browser session timeout defines the minimum duration of a HAN ses-
sion.

Web servers are designed to react to requests. In other words, the 
web server detects only user activity that is explicitly directed at it 
(for example, when a hyperlink is clicked); it cannot detect other 
user activity, nor whether the browser has been closed. Setting a 
limit on the period of user inactivity helps conserve resources. If the 
specified time elapses with no detectable user activity, the server 
closes the session and logs the user off, which frees up resources 
for further use. If user activity is detected before the timeout period 
runs out, the session continues and the timeout period countdown 
begins again.

Once a HAN license is in use, it remains in use for at least as long as the 
browser session timeout you set. Thus this setting can affect the avail-
ability of HAN licenses. The license is not released again until after the entire 
timeout period has elapsed with no user activity and the HAN server logs the 
user off. 
If the timeout period is too short, the user might have to log in on HAN repeat-
edly to access online resources. 
The default value for the browser session timeout is 20 minutes. 

The Data logging interval is defined by the number of datasets col-
lected before the data is written in the database. If the value is too 
low, the database will constantly be accessed for writing, which can 
impede system performance. The default value is 100 datasets. 
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Proxy
On the Proxy dialog page, you can configure the HAN server to access the 
Internet over a proxy server. 

In the Name of proxy server field, you can enter either the host name or the 
IP address of the proxy server. 
HAN can authenticate itself on the proxy server over a user account created 
for this purpose. Enter this login data in the User and Password fields on 
this page. 
If you activate the Optimized login on the proxy option, HAN will not have 
to authenticate itself for every request, but only once at the beginning of the 
proxy server session.

This option is not supported by all proxy servers, and under some 
circumstances might not be available. Contact your network admin-
istrator for information on the configuration of the proxy in question.
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To access local pages (for example, in the intranet) without going through the 
proxy, activate the Bypass proxy server for local addresses option and 
define the URLs that can be reached directly. 

Make sure you activate the Use proxy server option at the top of 
the dialog page. When you deactivate use of the proxy server, your 
settings are not affected, and are applied again thenext time you 
activate the “Use proxy server” option.

Any time you change settings on the Global or Proxy dialog page, 
your changes are not effective until after you restart the Apache 
service.
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UNC-based Access
Ideally, HAN’s administrative programs (Administration, Statistics, etc.) run 
in a terminal server session on the HAN server. This ensures that these pro-
grams can access all required components. 
You also have the option of running these programs in a shared folder on 
the network. 

Depending on the number of HAN access scripts, or on the size 
of your databases, it may take a while for HAN Administration, or 
the Statistics program, respectively, to open when started over the 
network.

Configure the following to enable UNC-based access:

 
Share the WebSrv folder (%ApacheHome%).

Configure the following values in the “Path” section of the han.cfg configu-
ration file in %HANHome%\bin: 
[Path]
ApacheHomeUNC=<UNC	path	to	WebSrv	share>
HANHomeUNC=<UNC	path	to	WebSrv	share>\hh\han

Edit the following values in the “Environment” section of the hhenv.cfg con-
figuration file in %HANHome%\bin:
[Environment]
nmDrive=\\<server	name>
nmPath=<share	name	of	the	WebSrv	folder>\hh\han

Edit the following values in the “Environment” section of the hhenv.cfg con-
figuration file in %HANHome%\System\Statis: 
[Environment]
nmDrive=\\<server	name>
nmPath=<share	name	of	the	WebSrv	folder>\hh\han
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Example: 
In the following example, the server on which HAN 2.x is installed is called 
DC01 and the ‘WebSrv’ folder is shared under the name “HAN2.” The con-
figuration files now contain the following entries: 

han.cfg:
[Path]
ApacheHomeUNC=\\DC01\HAN2
HANHomeUNC=\\DC01\HAN2\hh\han
nmHome=%nmDrive%\%nmPath%

hhenv.cfg:
[Environment]
nmDrive=\\DC01
nmPath=HAN2\hh\han
nmHome=%nmDrive%\%nmPath%

3.2   Configuring Authentication Services
Access to the HAN system can be controlled through HAN’s authentication 
services.

These are predefined HAN modules that detect user identity based 
on an authentication source.

The following can be used as authentication sources:

• NT login 
• IP address/host name check
• LDAP login 
• ADS login 
• NT4 login 
• NetMan login 
• PICA login
• ODBC interface to an ODBC-compatible database
• SISIS 

For detailed information on these authentication services, please 
refer to the appendix.
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Authentication Settings
Open the Authentication dialog page in the HAN Settings (Programs/
HAN/HAN Settings).

HAN distinguishes between implicit and explicit login. With implicit login, 
the user does not have to enter any data; for explicit login, the user enters a 
user name and a password for authentication. Implicit login is based on client 
IP address or host name and is independent of user identity. 
There are two types of explicit login:

• HTTP login dialog
• HTML form

The HTTP login method uses the following dia-
log:

You can edit the title of this dialog in the Title bar text for the login box field 
on the Authentication dialog page.

The actual appearance of the login dialog depends on the browser 
in which it opens.
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The other option is to have an HTML form open: 

This login page can be edited and, if desired, adapted (for example, 
to match your intranet pages). Make sure that the following HTML 
text is integrated in the form page unaltered:

<form	action=”/hhauth/login”	method=”POST”>
Name:&nbsp;<input	type=”text”	name=”User”	maxlength=”30”>
Password:&nbsp;<input	 type=”Password”	 name=”Password”	
maxlength=”30”	>
<input	type=”submit”	value=”Login”	style=”width:96px”>
</form>

If you call the login page over HTTPS, data is encrypted before 
it is sent to the HAN server. To do this, enter the URL as follows: 
https://<HAN server>/login/login.htm. Replace <HAN server> 
with the name or IP address of your HAN server.

Contact your network administrator for information on integrating a server 
certificate in Windows 2003 Server. Alternatively, you can use OpenSSL to 
create a certificate.
Furthermore, SSL modules must be linked in the Apache web server. The \
apache2\hh\han\SSL directory contains brief instructions on integrating 
SSL modules.
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Setting Up an Authentication Service
The following example shows how to set up an authentication service; in this 
case, IP authentication.

On the Authentication dialog page, click on the New icon.

This opens the Create Authentication Service dialog for defining the prop-
erties of the new authentication service.

In the Authentication service field, enter a name for the new authentication 
service (such as “IP Authentication”). The Designation (in this example, “IP”) 
is required for internal processing.
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Click on the “browse” button    next to the Module field to open the “Se-
lect File” dialog, which lists the available authentication services.

Select the desired module (in this example, auth_ip.dll) and click on Open.
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Each authentication service has its own set of parameters. When you click on 
Load, the parameters for the selected service are shown in the “Parameters” 
section.    
For the IP authentication ser-
vice the parameter is “CfgFile.”

Select Edit to assign a value to the selected parameter. In this case, the 
value is the complete path to a configuration file that defines the permitted 
IP address(es).

To enable this option, the user’s browser must be set to accept 
cookies from the HAN server.

HAN can check the validity of a login. To activate this feature, select the Use 
persistent cookies for login option. When this option is active, you can set 
the period (in hours) of validity for a login. 

If the “persistent cookies” option is not active, the login is no longer 
valid once the user has closed the browser.

Click to put a checkmark in the box next to Active to activate the authentica-
tion service and click on OK to save your settings. 
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To use an IP authentication service, you need to define access privileges on 
the “IP Ranges/Host Names” page.

You can specify various ranges of IP addresses and/or host names to define 
which clients are permitted to access HAN resources and which are explicitly 
denied access. You also have the option of defining a single user ID for a 
collection of IP address for purposes of statistical analysis. For example, you 
could create an IP authentication service for users whose IP addresses are 
located within the library, and enter “Library” as the user ID. As a result, the 
statistics database collects usage data acquired from all users authenticated 
by this service and attributes it to a user called “Library.”

To check computer host names, the Apache web server has to 
reverse resolve IP addresses. This functionality must be explic-
itly activated in the Apache configuration file (httpd.conf): 
       
HostNameLookups=On     
 The change is not active until you restart the Apache service.  
       
Important: If your Apache server cannot reverse resolve IP ad-
dresses, it could take a very long time to open a HAN account.

To test your system’s name resolution performance, run nslookup 
and enter the client IP address. The nslookup program should re-
turn the client’s host name.      
If this works, you can activate name resolution in the Apache serv-
er. If the host name is not returned, do not activate name resolution 
in the Apache server.

Remember to restart the Apache service any time you change HAN 
settings; otherwise, your changes will not be saved.   
If your changes affect only the definition of IP address ranges, how-
ever, it is not necessary to restart the Apache service.



Hidden Automatic Navigator  |  Manual

32

3   Installation and Configuration

If more than one authentication service has been defined, they are 
processed in order until one service has successfully completed the 
login, after which subsequent services are ignored.

You can use the Up and Down buttons to change the order of authentication 
services. If an IP authentication service is defined, this is the first service ap-
plied, because IP authentication does not require user input. 

3.3   Permissions
With HAN you can configure access privileges that permit or deny access to 
individual resources. 

Access privilege configurations define the conditions that users 
must meet before they can access a HAN resource. If the de-
fined conditions are not met, an error message (or a login page) 
is opened.

Access privileges can be allocated based on any of the following:

Global NT group membership
Local NT group membership
Host name
IP address
LDAP group membership
Environment variables

Each condition must be checked by a corresponding authentication 
service.

When login is successful, the authentication service can store us-
er-specific data in environment variables. When a HAN account is 
called, user privileges are checked to determine whether the cor-
responding values meet the requirements of the access privilege 
definition. If they do, then access is permitted; if not, the specified 
error page (or login page) is shown.
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Defining Permissions
Select Permissions from the Edit menu in HAN Administration to configure 
access privileges.

You can define new per-
missions and edit, copy 
and delete existing per-
missions here.
The following example 
illustrates the proce-
dure for defining per-
missions. The privileges defined in this example permit access only for library 
users (IP addresses located in the library). The one exception is a local group 
called “Staff.” Members of this group have access regardless of location. 

First of all, you need to select the authentication services that can determine 
the required information.
In this example, these are the auth_ip.dll and auth_nt.dll modules.

The next step is to check whether the authentication services have been 
configured. If they have not, then this must be done now (see section 3.2, 
Configuring Authentication Services for details).

To define new permissions, open the Permissions dialog (menu command: 
Edit/Permissions) and click on New. 
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Enter a name for the permis-
sion in the “Permit ID” field (in 
this example, “Library”). If de-
sired, you can enter a descrip-
tion as well (in this example, 
“For use inside the library only, 
plus staff”).

Click on New and select a condition as the basis of the per-
mission. In this example, we select both IP range and local 
NT group.

This opens a window for con-
figuring the definition. For an IP 
range:

Define the range of IP ad-
dresses to be granted permis-
sion. When Local NT group 
is selected, a dialog opens 
for defining the desired local 
group. Select the domain first, 
then the server and then the 
local group. 
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You can link conditions with logical ANDs and ORs, if desired. You can also 
negate a condition statement. To configure condition statements, double-
click on the desired condition or select it and click on Edit. In this example, 
we link the two conditions with a logical OR. 

The last step is to specify the HTML page to be shown in the event of error. 
Depending on the level of permission required, you might want to have a 
login page opened with a note on the type of login required. 

The HTML pages to choose from are stored in \apache2\hh\
han\hanerror.

In this example we do not want to open a login page, since we do not wish to 
permit access to anyone from outside the library. Instead, we prefer to show 
an HTML page explaining that only computers located inside the library can 
access the requested resources. To this end, we have created an informa-
tional page called “UseInLibraryOnly.htm”.
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3.4   HAN Administration
The HAN Administration program is the central element in HAN. This is 
where you can manage the online resources that HAN serves to your users.
Select Programs/HAN/HAN Administration to open HAN Administration.

The HAN Administration program window has the following components:
• A menu bar
• A toolbar
• The Accounts sidebar (on the left), showing Accounts (accounts groups 

and accounts not in groups), A to Z (alphabetical list of all accounts), and 
any Views you have created

• The script generator, divided into:
• the HTML view (upper right-hand pane), and 
• the Navigation view (lower right-hand pane)

The Accounts sidebar and the script generator are described in de-
tail in Chapters 4, Online Resources over HAN and 5, Managing 
HAN Resources.

When you open the HAN Administration program, the HTML view shows an 
information page that is updated by RSS feeds to provide links to the latest 
technical information about HAN, such as knowledge base articles and soft-
ware patches.
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Click on the  button to open this page at any time.

In HAN Administration, you can define global defaults. To configure settings, 
select View/Settings in HAN Administration:

Account Defaults

Under Account defaults you can define whether data logging is active for all 
HAN accounts and groups. If it is, the HAN account title is automatically used 
as the record ID in the log file each time a new record is written. 
You can choose to have all HAN accounts initially deactivated. For this pur-
pose, you can specify an HTML page to be opened when any account is 
requested under HTML page for notification “Deactivated”—for example, 
you might have a login page opened.

Inaccessible Domains

Under Inaccessible Domains you can define a blacklist that is applied glob-
ally. URLs that are specified here cannot be reached using a HAN account. 
If a blacklisted URL is requested, the page specified here under HTML page 
for notification is shown.
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Data Logging and Statistics

Under Document Types you can allocate document types to certain URLs or 
URL patterns (wildcards permitted). 

Document types are described in detail in section 7.3, Document 
Types.

Miscellaneous

Under Miscellaneous you can specify an HTML editor and define the back-
ground color in the Navigation view.
You can also enter the addresses of servers that cannot be reached over 
HAN. This is useful, for example, for preventing the use of one HAN account 
to execute another HAN account. Such server addresses might include the 
name of a link-out service, an OPAC system, or EJL Regensburg, for exam-
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ple. When HAN detects such an address, the active HAN account is closed 
and the rest of the URL is called by the browser.
If more than one port is bound to the Apache server, or if Apache is not 
reached over the default port (80), you need to specify the port over which 
HAN is called in the Apache port number field.

Cookies

Before a script is recorded (see chapter 4, Online Resources over HAN), all 
existing cookies are deleted. If you wish to save certain cookies (for example, 
ones that come from your intranet), use this dialog page to specify the names 
of the domains from which those cookies originate. 

Import from EJL

If you have installed the EJL module, this dialog includes a page with options 
for configuring EJL imports. 
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There are three ways to import data from EJL (for details, see chapter 6, EJL 
and HAN):
• Manually (complete or partial import)
• Automatically (complete or partial import)
• Import or update when EJL content is accessed

When you import EJL data to make a new account, you can have the account 
automatically added to a group. Under Inheriting account properties you 
can specify whether the new account inherits all inheritable group properties 
or not. 
HAN 2 supports the eventuality that an e-journal may have more than one 
starting URL. This means that access to an e-journal may consist of multiple 
HAN accounts. When importing accounts, you can configure certain options 
that affect how accounts are handled. You can choose from the following 
options:
• None (no HAN group/no anchor): The account is not assigned to any 

group
• HAN default import group: All newly imported accounts are assigned to 

the same group.
• HAN group indicated by anchor: Depending on the settings for the ‘An-

chor’ criterion in the EJL Administration in Regensburg, Germany, an 
account may be assigned to a HAN group of the same name. If such 
a group does not already exist, you can have HAN create it or assign ac-
counts with this anchor to the default import group in HAN. 

Furthermore, you can define the access data (library login data) for down-
loading the import file. 

Please note that the library ID is case sensitive.

These settings 
are applied glob-
ally to all accounts 
created through 
EJL import.

For details on which mod-
ule versions are installed, 
as well as on parallel us-
age of HAN licenses, select 
About from the Help menu 
in HAN Administration.
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3.5   Licenses
You can configure HAN to restrict parallel usage of online resources. For 
example, you could enter the number of licenses purchased for a particular 
e-journal as the maximum parallel instances permitted in your system. To do 
this, begin by selecting Licenses from the Edit menu in HAN Administration.

In the Licenses window, you can create new licenses and edit or delete exist-
ing licenses. Select New to open the dialog for creating new licenses.

Enter a name for the license in the License ID field and define the number of 
parallel instances you wish to permit in the Number of licenses field.

If you define a single license to cover multiple HAN accounts, all 
of the accounts taken together share only the specified number of 
parallel usage instances.

To check on the current usage of licensed HAN accounts, open the license 
monitor at http://<HAN server>/hanmonitor/.
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3.6   HAN and Apache
HAN leverages Apache web server technology and builds on its reverse-
proxy functionality. The HAN Administration, Settings and Statistics programs 
are Windows modules. Because HAN and Apache work closely together, 
some configuration changes in HAN are not effective until the Apache service 
has been restarted.
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3.7   Importing HAN Accounts
You can import HAN accounts from a text file containing comma-separated 
values. To do this, open the Edit menu and select Import/export /Import 
from text file. 

Enter the path to the text file and define how existing HAN accounts are to 
be handled. Click on Assign XML tags to assign HAN account properties to 
columns in the text file. 

You can skip a number of rows in the file by defining a value under Number 
of the first data row. Click on Add to add the selected HAN properties (XML 
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tags) from your list. You can use the Up and Down buttons to change the 
order of the properties. In the Delimiter field, you can specify the character 
that separates the columns in the text file.

If no separating character is specified, the columns have to be sep-
arated using tabulator spaces.

The appendix contains a list of all available XML tags and their 
descriptions.

Click on OK to confirm your settings. Once this dialog closes, you can click 
on Import to begin importing data.

3.8   Exporting HAN Accounts
You can export existing HAN accounts in XML format; for example, for ar-
chiving purposes. To do this, open the Edit menu and select /Import/Export/
Export.

This opens a dialog in which you can specify a path for the export. You can 
export all HAN accounts or only the accounts that you have selected in the 
Accounts sidebar.
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3.9   Updating HAN 1.6/1.7 to HAN 2.x
If you wish to update existing data from version 1.6 or 1.7, run the HAN 
Conversion 2.0 program after you have installed HAN 2.x. To do this, select 
Programs/HAN/HAN Conversion 2.0. 

Enter the path to your HAN 1.6/1.7 installation (\apache2\hh\han) and a 
path for the conversion log file. You can import log files from the HAN Statis-
tics program too, if desired. 

When log files are converted from earlier versions, HAN 2.x log files 
are automatically deleted.

Click on Start conversion to begin converting HAN accounts and log files to 
the HAN 2.x format.

Important: Do NOT copy your HAN 1.6/1.7 databases to your 
HAN directory. Version 2.x uses a totally new database format 
that is not compatible with files from the earlier version. Use the 
conversion program to convert existing data records to the version 
2.x format.

The conversion program can convert only files from versions 
1.6 and 1.7. If you have an earlier version, please update it to 
version 1.6/1.7 before converting files.
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3.10   A-to-Z List
HAN 2 has an alphabetical list option to help you find specific HAN accounts. 
You can view account names listed alphabetically or use the search function 
to find a particular account. 

You can integrate the A-to-Z list in existing HTML pages. To do this, 
add a link that points to the URL given below. To adapt the graphi-
cal presentation of the list, edit the base-style.css file in the \
apache2\hh\han\HAN-AtoZ directory.

For details on how to change functionalities in the alphabetical list (such as 
language defaults, for example), please contact H+H Software. 
The URL that calls the A-to-Z list is http://<HAN server>/HAN-AtoZ/atoz.
php.

3.11   Statistics Program
The Statistics program in HAN can help you carry out statistical analyses of 
HAN usage. The procedures involved are explained in detail in chapter 7.
To launch the HAN Statistics program, select Programs/HAN/HAN Statis-
tics. Select Settings from the 
View menu to configure global 
settings for the Statistics pro-
gram. 

The settings are divided into the 
following categories:
• Calculation
• Column titles in main table
• Column titles in document-type table
• Selection
• Graph types
• Graph colors
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Calculation

On the Calculation dialog page, you can define which data is output to the 
screen during calculation and configure the graphical representation of the 
charts.

If you select the “Use animated graphic display” option, calculation 
of the spreadsheet will be slowed down. For the fastest possible 
calculation, select “No screen output during calculation.”

The settings under “Table” let you define whether or not HAN accounts for 
which no record ID is found are included in the spreadsheet.
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Main Table: Column Titles

On the Main Table: Column titles dialog page you can adapt column titles 
to your requirements and preferences. Select the “Default titles” option to use 
the default settings for column titles defined in HAN. 

For details on the purpose of the main table, see section 7.1, Total 
Usage.
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Document-type Table: Column Titles

On the Document-type table: Column titles dialog page you can adapt 
column titles to your requirements and preferences. Select the “Default titles” 
option to use the default settings for column titles defined in HAN. 

For details on the uses of the document-type table, see section 7.3, 
Document Types.
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Selection

With the HAN Statistics program you can have spreadsheets calculated on 
the basis of users, record IDs, or other criteria. When choosing criteria, you 
have the option of selecting all criteria. The exact meaning of “all” in the “Se-
lect all” option is defined on the “Selection” dialog page as follows: 
• All items in the selection list: Only the elements in the currently active 

selection are included in the calculation.
• All items in the analyzed database: Elements that have not been se-

lected (e.g., because their data has not yet been collated) are included in 
the calculation. In some cases, the resulting spreadsheet may show en-
tries that were not present in the selection (e.g., deleted HAN accounts).

The option under “Selection of periods” lets you define whether the current 
period (month, quarter, half-year or year) is the default selection when the 
calculation function is called.

You can group record IDs under one separate record ID, called a 
“Meta-ID,” that summarizes the statistical values in the individual 
IDs.

Each ID, whether for a user, station or HAN account, can be assigned more 
than once to Meta-IDs, but the data can only be calculated if the ID is not 
used in multple instances. If you select the “Show only IDs not used” option, 
only record IDs not yet included in any Meta-ID are shown for selection when 
you create a new Meta-ID.
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When you select a record ID, HAN Statistics shows which accounts are 
assigned to this ID (in a Windows “tooltip”, displayed when you hover the 
mouse on the selected ID). The Show tooltips for non-existing record IDs 
option defines whether an empty tooltip opens if no record ID is found.

A Record IDs is not found, for example, if the account has been 
deleted in HAN Administration.

The options under “Initial settings” define the operations carried out when 
you open the HAN Statistics program. Select Collate data when program is 
opened to have the Statistics program update data on record IDs, users and 
stations at startup, either automatically or by opening an interactive wizard. If 
Open table automatically is selected, you can define which table is opened 
at startup. 

Please note that the table specified here is not re-calculated when 
it is opened on startup.

Alternatively, you can have the most recently active View opened (Load 
most recently used View on startup.) For details on the use of Views, see 
chapter 7, Event Logging and Statistical Analysis. 
HAN has two databases for data logging. One database contains records 
of all requests and the other, the sequential database, is used for statisti-
cal analyses. The two options Update database automatically on startup 
and Update database before each calculation define when the sequential 
database is updated.

You can update databases manually at any time by selecting Data-
bases/Update database from the Edit menu. For more information 
on the HAN databases see section 8.4, Databases.

Graph Types
The HAN Statistics program enables graphical display of statistical values. 
On the “Graph Types” dialog page you can specify the type of chart to be 
shown. 

Graph Colors
On the “Graph Colors” page you can define the colors used in the Statistics 
program to highlight values.
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4.1   HAN Accounts over HTTP and HTTPS

A HAN account is an online resource that is called over the HAN 
server. Each HAN account has its own properties (see also chapter 
5, Managing HAN Resources). One special property of a HAN 
account is the access script, which defines the response to a HAN 
account call. For example, the access scripts might execute a user 
login on the origin server, for example, or point the user’s browser 
to a particular HTML page.

This chapter describes how to create and edit HAN accounts. 
Generally speaking, HAN accounts can be divided into two different types:
• Accounts without manually recorded scripts; for example, accounts that 

use HAN’s IP authentication or HTTP login dialog mechanisms.
• Accounts with manually recorded scripts; for example, for explicit login 

on the origin server.

Creating a HAN account without recording a script
The most basic form of HAN account has a destination URL that is simultane-
ously the root URL of the desired online resource. When this is the case, the 
access script does not require editing; all required information is automati-
cally stored in HAN when the account is created. 
The following example describes how to create an account that opens the 
online magazine “Heise” using the URL “www.heise.de”.

Open HAN Administration.

Open the “New Account” dialog in one of two ways: Select New Account from 
the File menu, or click on the “New Account” toolbar icon .
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Enter a name for the account, the starting URL and, if desired, a group name. 

For details on account groups, see section 5.2, Account Groups.

Click on OK to confirm your input. The new account is shown in the Accounts 
sidebar. The HTML view shows the page that the account opens, and the 
Navigation view shows the access script automatically created by HAN.

The new account is saved automatically.
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The new account is fully functional as soon as it has been saved, and can be 
called by entering the URL: http://<HAN server>/han/Heise.

You can call the account from the HAN Administration program by 
clicking on the toolbar icon        or by selecting “Test account” from 
the shortcut menu.

To create a HAN account with an access script for login on the origin server 
with an HTTP login dialog, only one additional step is required: After creating 
the new account, add the required login data to the account properties (see 
section 5.1, Accounts for details).

When logging in using an HTTP login dialog, data is encrypted be-
fore it is sent by the browser. For this reason, data for an access 
script is not required. HAN sends the data when it is requested by 
the origin server.

When you make a HAN account that performs login in the background or 
guides the user to a specific HTML page, you need to record a script for the 
account. 
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Creating a HAN account with manual script recording
The first steps are the same as those described above. In this example, we 
will create an account that opens a page at the H+H HAN testing site (http://
www.hh-han.com/testarea/HANlogin.cfm?lg=0).
The page in question contains a link labeled “HTML form login.” When you 
follow this link, a login form opens. Enter “HAN” (without quotation marks) for 
both user name and password and click on “Login”. This opens a page with 
congratulations on your successful login and a link to another page, with a 
description of HAN’s automation features, which will be the target page of this 
sample HAN account.

Create a new account (called “Login”) with the root URL “http://www.hh-han.
com/testarea/formlogin/index.cfm?lg=0”.
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The next step is to begin recording the script. To do this, click on the Start 
recording icon: 

All subsequent actions, the results of which you see in the HTML view, are 
recorded in an access script as seen in the Navigation view.
To record a script, go through all the steps in the HTML view that you would 
otherwise go through on the web page itself (login, navigation, etc.). Enter the 
user name and password and click on Login to confirm your input. Then click 
on the link to the target page.

For thie time being, you can ignore the message about a persistent 
cookie (see section 4.4, Cookies for information). Click on the No 
button to confirm that you do not wish to save the cookie.

All required steps are now 
listed in the Navigation 
view.

Click on the Stop recording icon ( ) to end the script recording function, 
and then save the script. You now have a fully functional access script that 
you can call using the Testing function. 
In some cases, a HAN access script may contain calls that are not relevant 
for the desired process. The structure of an access script is described in 
detail in the following, followed by an example of how you can optimize the 
script just created.

Structure of an Access Script
An access script shows the process that executes when a URL is called in 
HAN. The steps are processed from top to bottom. Three levels are distin-
guished:
• Server nodes
• URLs
• Parameters

A server node indicates a change of servers. All URLs that are listed under a 
particular server node are automatically allocated to that server. Any number 
of URLs can be listed under each server node. 
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Each URL is assigned to the server node directly above it in the hierarchy. 
URLs can have any number of parameters.
Each parameter is assigned to the URL directly above it in the hierarchy. 
Each parameter has one value assigned to it.

When creating the account in the example above, one server node (www.
hh-han.com) and three URLs were recorded. These URLs do not all have the 
same number of parameters. In accordance with the hypertext transfer pro-
tocol (HTTP), both URLs and parameters can be sent using the POST and 
GET methods. HAN detects the correct method when the script is recorded 
and shows the result next to the URL.

A detailed explanation of HTTP and the GET and POST methods it 
defines is beyond the scope of this manual. If you need more infor-
mation on these topics, please see the recommendations for further 
reading listed in the appendix.

HAN stores the login data you enter while recording the script. 

This data is sent automatically when the script executes; thus no user input 
is required for login.
You can edit access scripts at any time. Double-click on the desired server 
node, URL or parameter to edit the properties of that element. Alternatively, 
you can open a shortcut menu to edit, add or delete script elements.

If the login data is encrypted and sent over HTTPS, the server node 
is labeled accordingly in HAN with https:

• Call over HTTP: http://<server>
• Call over HTTPS: https://<server>

You also have the option of configuring the use of HTTPS manually. 
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To do this, open the server node properties (double-click on the node or right-
click and select Server/Edit).

Optimizing an Access Script
Unlike a script used for programming, such as a Java or Visual Basic script, 
for example, a HAN access script may contain steps that are not relevant for 
the intended process. When a user navigates the the Internet, the path to a 
particular web page may be circuitous if the target is not known at the outset. 
If the exact target is known, however, the URL can simply be entered in the 
address line. 
The same principles are seen in a HAN access script. Initially, it contains all 
the steps that were carried out to arrive at the target. Afterwards, you can 
optimize the script so that the HAN account opens only the relevant page(s). 
These may include, for example, login pages, target pages, and any inter-
mediate pages that are required for subsequent processing (see section 4.2, 
Defining URL Parameters for details).
The goal is to limit scripts to the essentials and keep them as short as pos-
sible. The shorter the script, the faster HAN can process it. 
In this example, the login page and target page are the relevant pages. The 
optimized access script looks like this:

We strongly recommend creating a copy of the access script has 
soon as recording is completed. This way, you can edit the copy 
and still have the original in case anything goes wrong during opti-
mization (e.g., if you delete one URL too many).

When you restart the script recording process, all existing entries 
are deleted from the main script.
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4.2   Defining URL Parameters
When a web page is called, session-specific values in the URL may be sent 
to the web server; for example, to verify the validity of a session. When you 
record a script in HAN, such parameters are automatically included in the 
URLs recorded. If you test it right away, the script will work. When used later 
to call a page, however, such values may have expired, in which case the 
script fails. 
This is why HAN offers the option of defining these parameters in variables. 
This means that HAN does not send the value of a parameter as saved in the 
script, but rather the value that is used in the session by the origin server at 
the time the URL is called. 
The following demonstration illustrates this technique: Create a new account 
as described in section 4.1 with the URL “http://www.hh-han.com/testarea/
cookie/index.cfm?lg=0”. 
After the script has been recorded, the Navigation view should show the fol-
lowing:

The CFID and CFToken entries are URL parameters that have different val-
ues each time the page is opened. 

To determine which values might change every time a page is 
called, create the access script again in a new account with a dif-
ferent name at a later point in time, and check for differences in 
parameter values.

The following steps demonstrate the procedure for using variables to define 
URL parameters. 
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Double-click on the parameter to open its properties (or right-click on the 
parameter and select Parameter/Edit from the shortcut menu).

Activate the Parameter may contain different values for each call option.
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The value of the CFID parameter is replaced by the %url_parameter_0% 
variable. Click on OK to confirm. The %url_parameter_0% variable is now 
shown in the access script in place of the value recorded for the CFID pa-
rameter. 

As shown in the illustration above, HAN has inserted the variable not only 
once, but for every occurence of the CFID parameter. 

Now configure HAN to use a variable for the CFTOKEN parameter as well, 
and then optimize the script. The resulting script should now appear as fol-
lows:

Test your access script. If you delete the last URL, you will see the currently 
valid values for CFID and CFTOKEN when you call the account.
In addition to the relatively simple techniques described above for defining 
URL parameters, HAN offers more sophisticated methods, as described in 
the following. 
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Options for Defining Parameters in URLs
The following options are available in the “Add Parameter” dialog:
• Replace if parameter names and values are identical: HAN replaces 

values only for the selected parameters for which both name and value 
match the recorded value.

• Replace only if values are identical: In some cases, the value for a 
parameter may be stored in more than one location; for example, within 
a URL or as part of a value for a different parameter. Select this option 
to have HAN modify the value even if only the values match, and not the 
parameter names. In such cases it is important to include the parameter 
separator. 
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Example: The home page of Financial and Manager Accounting (FMA), an 
online magazine, always shows the latest issue, which changes at regular 
intervals. The access script for this resource appears as follows:
 

This script is fully functional, but it always shows the issue that was cur-
rent when the HAN account was created, rather than the latest issue. In this 
example, the value for the “isbn” parameter must be replaced by a variable 
in such a way that not only the “isbn” value is changed at login, but also 
the values for “goto_URL” and “chrome.” The parameter separator in this 
example is “/”.
In the Edit Parameter dialog, select both the Parameter may contain differ-
ent values for each call and Replace only if values are identical options.

You can deselect the in URLs option in this case, because no value for the 
parameter is bound to the URL itself. On the other hand, the in parameters 
option must be selected. 
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Once all variables have been added, the script appears as follows: 

• Use parameter for login: The script may show variables for login data. 
In this case, the specific data is stored in the account properties (see 
section 5.1, Accounts for details).

HAN can only replace a value with a variable if it is clear which 
parameter is thus defined. Some HTML pages contain the param-
eters read by HAN in hidden form fields. A common example is the 
“_Viewstate” parameter used in ASP pages. If a variable is used to 
send data over HAN to the origin server (using the POST method), 
HAN sends the wrong value.

Solution: Use the GET method to call the web page first, and then 
use POST to send the variable defined for the value.

Example:

This script fails because the current value of the “_Viewstate” parameter is 
not available to HAN. On the other hand, if the “/home.aspx” page is loaded 
beforehand using the GET method, HAN reads HTML code and detects the 
required values.
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Replacing a Session ID in a URL with a Variable
In some cases, the session ID is not appended to the URL, but rather is a 
fixed part of the URL itself. Nevertheless, with HAN you can replace this part 
of the URL with a variable. 
In the next example the session ID, 908735cd12, is part of the URL: “http://
server/directory/908735cd12/file.htm”. Select this URL in the Navigation 
view, right-click to open the shortcut menu and select URL/Session ID in 
URL to open the window for editing the URL.

Under URL segment that precedes the session ID select that portion of the 
URL that immediately precedes the session ID. This enables HAN to identify 
the session ID, which it then replaces with the %URL_parameter_x% vari-
able. The URL with session ID parameter field now shows the URL with the 
session ID variable. Click on OK to save your changes. 
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4.3   Conditional Scripts
The HAN accounts created in the previous examples were designed for im-
mediate login. In other words, as soon as the HAN account is called, the user 
is logged in on the content provider’s web server. This solution is ideal for ac-
cessing online resources that require user login. Such resources can include 
online databases, archives, and others.
Some websites, however, offer both freely accessible and password-protect-
ed resources. For these websites, you need HAN accounts that only log the 
user in when login is required. Such sites might include online magazines 
that provide free access to abstracts, but require user login before complete 
articles can be read.
HAN lets you write conditional access scripts; for example, to perform 
login only if a certain URL is detected. 
The first step of this procedure is the same as that outlined above for creat-
ing an account and beginning to record a script. In the second step, login is 
performed, recording is stopped and then conditions and variables for the 
conditional script are defined. 
This procedure is demonstrated in the following using the H+H HAN testing 
site.

Create a new HAN account for accessing the website called Public Web Site 
with Links to Protected Pages (http://www.hh-han.com/testarea/
scriptlogin/index.cfm?lg=0).

Begin recording the script and navigate to the page with links labeled “Ab-
stract” and “Publication.” Login is required only for publications, not for ab-
stracts. Select a publication and log in. Stop the recording and save the re-
sults. 

The result at this point is a fully functional script that has two disadvantages: 
First, it will always perform the login, and second, it always opens the same 
publication.
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The third step is to determine which URL triggered the login prompt, and 
then edit it in a subscript. In the current example, the login prompt opened 
when you clicked on the link to the publication. The URL in this link differs 
from the others encountered so far at this site in that it sends a parameter 
called “type,” with the value “pub,” to the web server. Furthermore, this URL 
contains an identifier for the requested publication (“ID=57889”).

As a rule, the last URL shown before the login (which usually uses 
the POST method) contains the condition to be used in your con-
ditional script.

Open the URL properties page (double-click on the URL or select “URL/Edit 
URL” from the shortcut menu) and select the Mark as a subscript condition 
option. Enter a name for the subscript in the Name field.

It is a good idea to use a descriptive name, such as “Complete text” 
(or, in this example, “Plain text”).

Click on OK to confirm your 
settings.
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HAN modifies the existing script and moves all URLs to the subscript.

The Navigation view now shows a second page with the name of the sub-
script. This page is divided into two parts:

• The condition is shown in the upper portion of the page (icon: )
• The lower portion shows the URLs that are called if the condition is met; 

in other words, when the URL at the top of this page is called (icon: )

The URL that forms the condition is the first URL called when the 
condition is met.

The last step is to define a variable for that value in the condition which can 
change every time the page is opened. (For details, see section 4.2, Defin-
ing URL Parameters.) To do this, open the properties page for the “ID” pa-
rameter in the condition-URL and select the options Parameter may contain 
different values for each call and Replace only if parameter names and 
values are identical.

Unlike variables in the 
main script, HAN uses 
asterisks (“*”) to indi-
cate variables in sub-
scripts.

Click on OK to confirm your set-
tings. 
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All instances of the parameter which have been replaced are replaced by 
variables throughout the subscript; in this case, by %ID%. 

The last step is to check whether the calls in the main script are still correct. 
All URLs that came after the point in the main script at which you inserted a 
condition have been moved to the subscript.

You can begin recording again in the main script; this will not affect 
existing subscripts.

In this example, the main script is functional. The first URL can optionally be 
deleted to optimize the script, since it is not needed.
Test your script. The login is not performed until the subscript is called. Al-
ternatively, you can replace a parameter the condition-URL with a variable. 
To do this, open the URL properties and enter an asterisk in place of the 
parameter you wish to replace. 

For example, take the URL “http://server/directory/id5798621/text.html” as 
the condition. 

The subscript is as follows:
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In the URL properties, the “id5798621” value is manually replaced by deleting 
that text and entering an asterisk (“*”).

Afterwards, HAN replaces all instances of that parameter in the conditional 
script.

4.4   Frames
Web page structure can vary widely. In addition to the use of tables, the use 
of frames is widespread. 

A frame-based page consists of a number of web pages displayed 
at one time. A definition file called a frameset controls how the 
frames are displayed on a given web page.

HAN detects the use of frames in a web page and marks them in the Navi-
gation view. The  icon indicates a frameset, and a frame is marked by 
. When using HAN, it is important to make sure the last URL in the access 
script contains the definition file for the frame set. If the last URL points to 
a page that forms a single frame in the set, then the user will see only that 
frame when the HAN account is called. 

You can explore the H+H HAN testing site at http://www.hh-han.com/
testarea/HANlogin.cfm?lg=0 to familiarize yourself with frames. 
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For the following demonstration, create a HAN account to the “Frame-based 
HTML page” at http://www.hh-han.com/testarea/frame/index.
cfm?lg=0. 
The structure of this page is clearly labeled: 

When you navigate to this page, HAN writes the following access script: 

When this script executes, however, only the last frame (main.cfm) is shown. 
To have the HAN account open all frames that make up the page, delete all 
frame URLs so that only the frameset URL (in this example, index.cfm) is 
called.



73

4   Online Resources over HAN

4.5   Cookies

Cookies are packets of information from a web server that are 
stored on the client by the browser. Web servers can use cookies 
to store information in the form of values assigned to parameter 
names. Generally, a distinction is made between persistent cookies 
and session cookies. Persistent cookies are saved beyond the end 
of the browser session. Session cookies, on the other hand, are 
deleted when the last browser instance is closed.

What information a cookie contains depends on the web server it came from. 
Providers of online resources often set persistent cookies when users log on. 
Usually a message box opens (such as a “remember me” dialog) offering this 
as an option. HAN supports the use of persistent cookies. When HAN detects 
a persistent cookie from a content provider while recording an access script, 
it opens a window prompting you to accept or refuse the persistent cookie. 

If you click OK, HAN saves the cookie in the account properties and sends 
the stored information as requested when the script executes. In this case, 
the access script is almost complete and you do not need to create a login 
script. On the contrary; you can delete almost all of the recorded URLs from 
the script. 
HAN shows the  icon in the Navigation window to indicate that the ac-
count uses a persistent cookie.
The advantage of using cookies is that the access script consists of only one 
URL. The shorter the script, the better the performance.
The use of cookies, however, can also have disadvantages. For example, if 
the content provider changes the web server’s mechanism for reading cook-
ies, your HAN account will no longer work. Furthermore, cookies can expire. 

Not all persistent cookies contain login data. Cookies are often 
used to track the websites visited by a browser and compile user 
profiles.
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4.6   Advanced Settings

Note: Advanced settings should be configured by experienced 
HAN administrators only. Faulty configurations may prevent 
HAN from functioning correctly.

HAN has a number of advanced configuration options for administrative pur-
poses.

Advanced settings are inactive when HAN is initially installed. 
To activate these configuration options, open the han.cfg 
file stored in the \apache2\hh\han\bin directory and enter 
UserMode=Admin in the “Settings” section.

This activates the “Advanced” property in account properties (see section 
5.1, Accounts for details).

With this property, you can configure whether the account’s URL is displayed 
in the user’s browser in encrypted form. The following shows an example of 
the two forms:
• Unencrypted: http://han2-beta/han/Login/www.hh-han.com/testarea/

formlogin/HANatwork.cfm
• Encrypted: http://han2-beta/han/Login/001259331e25143a143a4d7c4d

390e321f2b1324.de/000d59331e251439052f023a112d15/000e59331e
25142b1d360237013f0f38/000e59331e2514051d0a321f31072c1e.cfm

If the URL is encrypted, the user cannot tell what page is loaded. You can 
also select the option to permit only encrypted URLs.

Encrypted URLs may cause HAN to function incorrectly. This is fre-
quently the case when complex Java scripts are used to open new 
windows.
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Under “Parameter conversion in Java scripts” you can configure how HAN 
handles problematic Java scripts.

Discussion:
If a page that HAN loads contains links to another page, these are auto-
matically rewritten so that they are redirected to the HAN server. With Java 
scripts, however, it is not always easy to tell what the script does and whether 
URLs should be handled as HAN-URLs or “normal” URLs.

Here is an example: An “openWindow” function has been defined with two 
parameters: parameter 1 identifies a magazine and parameter 2 is a URL. 
When the script executes, the magazine specified is opened in a new win-
dow. The source code contains the following:

onClick=”openWindow(12345,http://server/directory/index.html)”

In this case the URL that is passed to the Java script must be converted to a 
HAN-URL; otherwise, the new URL is not opened by HAN. 
The “transferSelection” function in the next example also contains two func-
tions; again, a magazine ID and a URL. The difference in this example is 
that the second parameter is not called directly; instead, the web server is 
informed of the destination URL. The Java script then generates the follow-
ing call: 

http://server/directory2/identify.html?Magazin=<Parameter1>&DestinationP
age=<Parameter2>

The source code contains the following:

onClick=”transferSelection(12345,http://server/directory/index.html)”

In this case, HAN must not change the second parameter, because the con-
tent provider’s web server cannot process the HAN-URL.
As the examples above show, HAN cannot interpret the Java syntax to dis-
cover whether a URL should be converted to a HAN-URL or not. 
For this reason, you have the option of storing account-specific defaults for 
complex Java scripts. Click on “New” and enter the name of the Java script. 
Under “Parameter to be converted,” specify the parameter to be converted to 
a HAN-URL (for the first example given above, “2” is entered, indicating the 
second parameter):
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For the second example above, use the following settings:

We do not recommend using this function unless an error occurs 
when a HAN account is called. Most Java scripts are automatically 
interpreted correctly by HAN.
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5   Managing HAN Resources

5.1   HAN Accounts

A HAN account is an online resource that is called over the HAN 
server. Each HAN account has its own properties. One special 
property of a HAN account is the access script, which defines the 
response to a HAN account call. You can use access scripts to 
have a HAN account automatically login on the origin server, for 
example, or to guide the user to a particular HTML page.

Each HAN account has a number of properties, presented on various dialog 
pages:
• General information (Global page)
• Source and publisher
• Comments
• Metering functions (Data Logging page)
• Definitions of document types 
• Licensing
• Login data
• Status (active/inactive, period of validity) (Deactivate page)
• Access privileges
• Masking IP address
• Whitelist (Accessible Areas page)
• EJL (optional)

To open account properties, select the account, open the Edit menu and se-
lect Accounts/Properties or right-click on the account and select Account 
properties.
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Global
The Global page contains general information about the account.

Some fields cannot be edited; for example, “Link syntax” (contains 
the account’s HAN-URL).

The link ID is the name of the account. If the account name contains any 
characters that are not allowed in URLs (such as umlauts or other special 
characters), these are automatically deleted. Click Edit to customize the link 
ID. 
In the “Subject” field, you can assign a subject as a criterion for sorting your 
HAN accounts. You can also enter the ISSN and e-ISSN if desired. This in-
formation is included in the table of all accounts (see section 5.4, Overview) 
and in the alphabetical list of accounts.

To edit the choices available under “Subject,” open the Edit menu 
in HAN Administration and select Subjects.

The “Periods” field defines the licensing period during which this account is 
valid (see also chapter 6, EJL and HAN.)
The “Root URL” field shows the URL with which the account was created. 

Source and Publisher

On the Source and Publisher dialog page you can specify these details 
pertaining to the target page of the HAN account. This information is shown 
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in the synoptical table (see section 5.4, Overview) and in the alphabetical 
list of accounts.

To edit the lists of sources and publishers, open the Edit menu in 
HAN Administration and select Publishers or Sources.

Comments

The Comments field lets you store additional information about the online 
resource. 

Data Logging

On the Data Logging page you can configure the logging function to col-
lect statistical data on the use of the online resource that this HAN account 
opens. The record ID identifies this account in the HAN Statistics program. 
Activate the “Data logging” option to switch on this function. 

The Record ID must not be longer than 30 characters. If a longer ID 
is entered, HAN will truncate it and discard the excess characters.
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You can define URL patterns for statistical analysis of HAN account usage. 
If the URL called does not match any URL pattern defined for the account 
(under “URL template”), usage of that account is not included in the statistical 
evaluation.
There are basically two modes of statistical analysis: 
• All calls within the scope of a given account are analyzed together.
• Only calls directed to a URL that matched a specified URL pattern are 

analyzed.

The problem with the first mode is that HAN cannot tell how long the online 
resource specified in the account is used, nor when the user moved on to a 
different page. 

The default setting in the Statistics program corresponds to 
the first mode described above: all usage of all URLs in the ac-
count is calculated as usage of the account. When this mode 
is active, any URL patterns you have defined are ignored.

To change this setting, you need to edit the “nmstatis.cfg” file stored in the \
apache2\hh\han\system\statis directory. In the “Record ID” section, 
change DontUseHANTemplates=1 to DontUseHANTemplates=0. 
With this setting active, only usage of URLs that match a specified pattern 
is counted as usage of the account. With the default settings, each HAN ac-
count has its root URL defined as a URL pattern. 

The setting described above in the “nmstatis.cfg” file is global. If 
the account contains a server change and the URL pattern does 
not cover the subsequent server, usage data logging may be in-
complete.

Document Types

Defining document types in HAN lets you run statistical analyses in ac-
cordance with criteria used by web-counter programs. On the “Document 
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Types” page of account properties, you can assign URL patterns to document 
types. Click on New to open the dialog for allocating types. Enter your URL 
pattern(s) and allocate document types as desired. For details on document 
type designations, see section 7.3, Document Types.

Licensing

On the Licensing page of the account properties, you can activate account-
specific licensing and define a license ID for the HAN account. (See section 
3.5, Licenses, for details on defining a license ID.)

Login

HAN helps you manage the login data required for access to online content. 
In the Navigation view, right-click and select Edit from the shortcut menu to 
open the Edit Parameter dialog, and select “Use parameter for login as:” to 
have the user data displayed and managed in the account properties with its 
variables. On the “Login” dialog page of the account properties, you can edit 
the values that have been stored. 
If you select Use login data for HTTP login (dialog box) as well, HAN will 
use the data entered here for HTTP login.
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Deactivate

Select the Deactivate account option on the Deactivate page to make the 
account generally inaccessible. Alternatively, you can specify a date under 
Valid until beyond which HAN automatically deactivates the account. In ei-
ther case, the HTML page you specify here is opened—for example, showing 
an error message—when a user attempts to call the account.

Permissions

On the Permissions dialog page, you can allocate existing privileges or 
define new privileges for access to the HAN account. The “Permit ID” field 
shows the designation of the privileges assigned.

For detailed information on the function and configuration of per-
missions, see section 3.3, Permissions.
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Masking IP Address

With the default settings, HAN uses the IP address of the HAN server in 
communication with a provider of online resources. In some cases, however, 
you might wish to use a different IP address for communication with certain 
providers. You can define an IP address for this purpose on the Masking IP 
address page. If you do, then that IP address is used for communication with 
the origin server whenever this account is called. 
One example for the use of a masking IP address is to enable IP-based ac-
cess for clients from computers outside the permitted IP range.

The masking address you specify must be a real IP address; in 
other words, it must be both bound to the network card in the HAN 
server and defined in the router and the DNS. Contact your network 
administrator if you wish to use masking IP addresses in HAN.

Accessible Areas

HAN lets you restrict access to websites that may be linked in the page(s) 
opened by a HAN account. Activate the Apply ‘Accessible areas’ defini-
tions option to define a whitelist for user access. The “Accessible domains” 
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section shows the URLs that can be called from within this account. The 
“Inaccessible URLs” section defines subareas within accessible domains that 
are excluded from user access (for example, pages with forms for editing a 
subscription to an online resource).

The root URL of an account is automatically entered in the Acces-
sible domains section.

Advanced
The options on the Advanced dialog page are described in detail in section 
4.6.

5.2   Account Groups

You can group accounts in HAN according to your choice of criteria. 
An account group can be assigned properties that are independent 
of account properties. The members of a group can inherit some or 
all group properties, or retain all of their individual properties.

To create a new group, open the Edit menu and select Groups/New or right-
click in the Accounts sidebar and select New Group from the shortcut menu.

Enter a name for the group and add HAN accounts from the list under “Ac-
counts not included in any group.”
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Adding Accounts to a Group
There are several options for adding existing accounts to a group:
• Open the Edit menu and select Groups/Edit or right-click on a group and 

select Edit group from the shortcut menu to open the window for editing 
groups, in which you can add and remove accounts.

• Use drag-and-drop to add an account to a group. In this case, the ac-
count retains its individual properties.

Removing Accounts from a Group
The options available are similar to those for adding groups:
• Open the Edit menu and select Groups/Edit or right-click on a group 

and select Edit group from the shortcut menu to open the window for 
editing groups, in which you can add and remove accounts. 

• Right-click on an account and select Remove account from group from 
the shortcut menu.

• Select the account, open the Edit menu and select Accounts/Remove 
from group.

Save group as Meta-ID for record
You have the option of saving a group as a record Meta-ID (for the definition 
Meta-IDs, see Chapter 7, Event Logging and Statistical Analysis). To do 
this, select the group you wish to save as a Meta-ID, right-click on it and se-
lect Save group as Meta-ID for record from the shortcut menu. The record 
Meta-ID is generated in the HAN Statistics program for the selected group 
and is an aggregate of all accounts in the group. 
The resulting Meta-ID will not be dynamically updated. In other words, chang-
es made later are not shown. To update the record ID, you need to save the 
group as a Meta-ID again. 

Group Properties
Like HAN accounts, account groups also have properties. 
• General information (Global page)
• Source and publisher
• Comments
• Metering functions (Data Logging page)
• Definitions of document types 
• Licensing
• Login data
• Status (active/inactive, period of validity) (Deactivate page)
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• Access privileges
• Masking IP address
• Whitelist (Accessible Areas page)
• EJL (optional)

To view or edit group properties, open the Edit menu and select Groups/
Properties or right-click on the group and select Group Properties from the 
shortcut menu.

The difference between group properties and account properties is that each 
group property can optionally be inherited by all the accounts that belong to 
the group. Each group property page also shows which account members do 
not use that property.

If an account belongs to a group, the option of applying the group 
value is available for each property.

Example: Data logging property page for an account that does not belong 
to any group: 
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Example: Data logging property page for an account that belongs to a group: 

In the Accounts sidebar, an exclamation point next to a property 
indicates whether all members of the group use the value defined 
for the group property.

At the account property level within the group, an 
exclamation point indicates an account property 
that differs from the group property.

5.3   Views

Views let you use your choice of criteria from among the account 
properties to search for accounts. Views also let you transfer prop-
erties to all accounts that match the criteria defined for the view.

Views complement the account-grouping functions in the administration of 
HAN resources. While an account can only be a member of one group and 
thus can inherit properties from only one source, in may be desirable under 
certain circumstances to transfer account properties to multiple accounts ac-
cording to special criteria. This is possible with Views. 

Example: A group called Springerlink includes all accounts that access the 
Springerlink content provider. While it may well make sense to use the record 
ID as group ID, it might not make sense to make access privileges content 
provider-dependent. 

Note: Views do not have individual properties. Unlike group 
membership, the occurence of an account in a View does not 
mean that that account cannot be found using any other View.
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Defining a View
Select Views from the Edit menu in HAN Administration, or right-click in the 
Views window pane of the Accounts sidebar and select Views from the short-
cut menu.

Click on New to define a new View.

Enter a name for the new View in the “Name” field. The description is option-
al. The “Active” option determines whether the View is shown in the Accounts 
sidebar. On the “Global” dialog page, you can define the criteria according to 
which the View is generated.

You can use wildcards in the “Title,” “Subject,” “Publisher” and 
“Source” fields.
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Example: If you enter “H+H” in the “Title” field, this View will show all accounts 
called “H+H”. (Since accounts must have unique titles, this search would not 
yield more than one account.) If you enter “H+H*” (without quotation marks), 
the View will show accounts with names that start with these three charac-
ters, followed by other characters (for example, “H+H web page”).
On the “Advanced” dialog page, you can specify criteria for an SQL statement 
that defines the View.

Click on the Test button to test whether the SQL statement has been defined 
correctly. If you have defined options on both the “General” and “Advanced” 
dialog pages, the setting for the “Use SQL statement” option determines 
which definition is used.
Once you have completed these configurations, the new View is shown in 
the Accounts sidebar in HAN Administration, with the name you defined in 
its title bar.
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Example of the “H+H” View
Defining the View:

“H+H” View as shown in the Accounts sidebar:

The exclamation point indicates that the “H+H Demonstration Account” be-
longs to an account group.

Inheriting View Properties
You can define a View so that it finds certain accounts and then applies a 
specified property to them. Open the Edit menu and select Views/Inherit 
View properties or right-click on the View and select Inherit View proper-
ties from the shortcut menu to open the View properties. 
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Select the property in the sidebar on the left to open the corresponding dialog 
page, where you can configure the desired settings for each account that the 
View finds. Click on Select all to have the settings applied to all accounts in 
the View’s list. 

Your settings are not saved in the View. The next time you select 
Inherit View properties, all fields will be blank.

Settings inherited from a View overwrite the account’s previous properties, 
regardless of whether the account belongs to a group.

5.4   Overview
Open the Edit menu in HAN Administration and select Overview to open a 
table that lists all accounts with their properties.

For a detailed view of account properties, double-click on the account in this 
list, or select the account and click on Show properties. When you click on 
Load web page, the root URL in the account is opened in the HTML view.

You can filter the display by entering criteria in the first line (“Enter 
text here”).
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6   HAN and the Electronic Journal Li-
brary (EJL)

6.1   EJL Interface
HAN is equipped with an interface to the Electronic Journal Library in Re-
gensburg (EJL). This means your HAN server can provide direct access to 
your institution’s pages at EJL. With this interface, a HAN account is created 
or updated every time one of your users calls a journal over the EJL page. 
Options are also available for manual and automatic import of EJL links. Fur-
thermore, the HAN 2.x offers optional support for licensing time periods as 
well as for management of multiple HAN accounts—with different starting 
URLs—for a single e-journal.

The EJL options are available in HAN only if the corresponding 
module was selected during HAN installation.

The following must be configured to enable the EJL interface:
• Import the EJL title list into HAN
• Configure HAN settings in EJL administration
• Select the e-journals to be offered over HAN in EJL license administration
• Set up automatic collation of data

6.2   Importing the EJL Title List Manually
There are three ways to import and update EJL data:
• Manually (complete or partial import)
• Automatically (complete or partial import) 
• Import or update when EJL content is accessed

Manual import must be explicitly initiated by the HAN administrator. 
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In HAN Administration, open the Edit menu and select Import/Export/Im-
port from EJL:

The settings shown that can be inherited and imported correspond to the de-
fault settings in HAN Administration. For details on these and other settings, 
see section 3.4, HAN Administration. 
You can import either selected data, such as “Ancor”, “Publisher” or Subject,” 
or complete datasets.

For details on inheriting properties, see the description of the set-
tings dialog in section 3.4, HAN Administration.

A log file of import operations is written in the %HANHome%\EZ-
BLogs directory.
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6.3   Collating HAN Accounts with EJL 
Automatically
Rather than importing EJL data manually, as described above, you can con-
figure HAN to collate its EJL accounts with online EJL data automatically at 
regular intervals. During automatic collation, HAN updates existing accounts 
and checks whether any accounts have been added to or deleted from EJL 
license administration; if so, HAN adds and/or deletes accounts in your sys-
tem accordingly. 
Automatic collation can be scheduled using the AT command or your operat-
ing system’s Scheduled Tasks tool. Automatic collation is performed when 
the EJL import program is called as follows (replace the %HANHome% vari-
able with your HAN installation directory): 
%HANHome%\bin\HANImpoEZB.exe
Add the /hide argument if you do not want the graphic interface displayed 
during collation. The /clean argument deletes all accounts that had been 
created by the EJL interface but are no longer found in EJL license admin-
istration. 

You can also access the EJL database cleanup feature from the 
Start menu (EJL Cleanup).

In the following example, the import program was called with the /clean 
argument:

With the /clean argument, no new accounts are created and 
existing accounts are not updated.

No backup copies of accounts created in HAN when the accounts 
are deleted during automatic collation.

A log file of import operations is written in the %HANHome%\EZ-
BLogs directory.
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Discussion: Using the AT Command
The first step is to write a short CMD script containing the import program 
call. The following example is based on a HAN installation in D:\Program 
Files:
“D:\Program	Files\HAN2\WebSrv\hh\han\bin\HANImpoEZB.exe”	
/hide	
It is essential that you save the script in “D:\Program Files\HAN2\WebSrv\hh\
han\bin” and name it “EZBImport.cmd”. Then open the Windows command 
prompt and enter the following command:
AT	1:30	/Every:So	D:\Programs\HAN2\WebSrv\hh\han\bin\EZ-
BImport.cmd
The resulting AT job executes every Sunday at 1.30 a.m. and performs a 
complete collation, including deletion of accounts that have been deleted 
from EJL license administration.

For more information on configuring AT jobs, please refer to the 
documentation on your operating system.

In addition to completely automated data collation, HAN offers the option of 
automatic partial importing. This entails writing a configuration file that de-
fines criteria for the partial import. The import program is then called with the 
following argument: /inputfile:<path	to	configuration	file>.

Configuration file structure:
[Input] 
Defines the required arguments. 
Publisher_1=<name	of	the	publisher> 
Defines the name of the publisher for the first partial import.
Subject_1=<subject>  
Defines the subject.
HANGroup_1=<HAN	group>
Defines the group (if any) into which new accounts are to be imported.

If you wish to perform multiple partial collations with an automatic program 
call, you can define all criteria in the configuration file:
[Input]
Publisher_1	=	
Subject_1=
HANGroup_1=
...
Publisher_n	=	
Subject_n=
HANGroup_n=

The global settings are applied for automated import of EJL import.
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6.4   Configuring HAN Settings in EJL 
Administration

In the Settings column in EJL Administration, click on the Library settings 
link. 

Now follow the Edit settings for HAN server pages link.

In the “HAN server settings” field, enter the following value (insert the name 
of your HAN server in place of <HAN server>):

Selecting the e-journals to be Offered over HAN in EJL License 
Administration
After you have entered the HAN server in EJL administration, you need to 
specify which e-journals are to be opened over the HAN server.

In the License administration column in EJL administration, select the Edit 
link.

Specify the desired criteria on the Search page and open the Results page. 
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You should see a new column, with the header Journal via HAN. Select the 
accounts that will offer EJL links over HAN. 

6.5   Rules for EJL Update
One of the most basic difficulties in collating data between HAN and the EJL 
involves the determination of when an account has been modified and when 
a new account should be created for a new licensing period. Because there 
is no unambiguous criterion, HAN requires rules that serve as a basis for in-
terpreting the data received. Four properties are designated as fixed criteria: 
title, anchor, licensing period and URL.
The following rules apply:
If three of the four criteria remain unchanged: the existing account is updated. 
If only the URL is changed: the existing account is updated
If only the licensing period is changed: the existing account is updated
Special case: anchor and URL are changed: the existing account is updated
In all other cases, a new account is created.

The following exception to Rule 4 above applies: If no licensing 
periods are defined (i.e., empty licensing period fields) and the 
anchor and URL are different, a new account is created.

Another special case arises when EJL accounts are blocked from EJL up-
dates. Not only the specified account, but the e-journal itself is blocked. This 
is designated by the EJL ID. This means that for a blocked journal no 
changes are made. This includes creating new accounts for new licensing 
periods and deleting accounts by activating the “Cleanup” function. 
Furthermore, HAN Administration detects whether an EJL account has been 
modified manually in the Administration program (such as a change in the 
root URL, or URLs added) and informs the user in such cases that the chang-
es will be overwritten during the next update account if this account is not 
blocked from updates. If a main script is detected during EJL collation, the 
existing script is backed up to the hh\han\hancfg\Backup directory and 
the account is created once again based on the EJL data received.
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7   Event Logging and Statistical Analy-
sis

7.1   Total Usage
The Statistics program in HAN can help you carry out statistical analyses of 
HAN usage. The main table shows details on total usage.

To launch the HAN Statistics program, select Programs/HAN v2/HAN Sta-
tistics. You can configure HAN to collate data and update the main table 
every time the Statistics program is launched. 

Open the File menu and select “Main table” (or click on the New table icon) 
to run an analysis of total usage. 

On the left-hand side of the main table, you can define the basis for cal-
culation. Open Basis for calculation to define the basis for the statistical 
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analysis. Select either record ID, users or stations. Your selection here de-
termines which rows are shown in the table. In the Record ID section, select 
the record IDs of the datasets to be included in the calculation. You can select 
some or all record IDs. 

The effect of the “Select all” setting is determined by your settings; 
see section 3.11, Statistics Program for details.

If you find there are record IDs missing from the spreadsheet, this 
may be due to the fact that the data has not been collated. To col-
late the data, right-click on “Record IDs” and select “Collate record 
IDs” from the shortcut menu.

In the Collate Record IDs window, you can select the mode for collating 
data.

• Click on “Account files” to compile a table of record IDs from the list of 
accounts in HAN. Deleted accounts are not included in later statistical 
analyses.

• Click on “Sequential database” to compile a table of record IDs from the 
sequential database. Deleted and renamed record IDs are included in 
the statistical analysis.
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The Users and Stations sections let you select the users and stations to be 
included in the calculation.

You can collate these records as described above. This may be 
necessary in order to view all records.

The Attributes section lets you select attributes to be included in the calcula-
tion of statistics.

You can choose from the following attributes:
• None – Accounts without attributes are included in the calculation. 
• /NA – Deactivated account.
• /NL – No license available.
• /NR – The user did not have sufficient rights to call the HAN account.

The NA, NL and NR attributes are automatically allocated by HAN if the cor-
responding condition is met when an account is called. Another form of at-
tribute is document type; see section 7.3, Document Types, for details.
In the Periodicity section, you can select the period(s) to be covered in the 
calculation. Select a number of months, quarters, half-years, years, or no 
periodicity. You can define a period as the basis for periodicity in the Period-
icity section. 

If the current time period is not available for selection under “Peri-
odicity,” you need to collate your databases. To do this, open the 
Edit menu and select Databases/Update database.

If you select “None” for the periodicity, you can specify a period by 
selecting Set starting date and Set ending date in the shortcut 
menu:

You can define filter criteria using the Minimum time, Maximum time, Mini-
mum downloaded bytes and Maximum downloaded bytes options. 
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To do this, right-click on the section and select the desired items from the 
shortcut menu.
The Meta-IDs, Meta-Users and Meta-Stations sections let you have certain 
datasets automatically grouped for calculation. The resulting values are 
shown in the spreadsheet under the name of the Meta-ID.To create a new 
Meta-ID, right-click on the desired category (for example, “Users”) and navi-
gate the shortcut menu to open the dialog for editing the Meta-ID (in this ex-
ample, “Meta-Users”):

You can create, edit and delete Meta-IDs here. Click on the New button to 
create a new Meta-ID.

Enter a name and, if desired, a description and add the desired IDs (in this 
example, “Users”) to the Meta-ID. The last step is to confirm your selection 
by clicking on OK. Click on the Create button to define your own ID. You can 
use an asterisk (“*”) as a wildcard. All IDs that match the criteria you specify 
are automatically summarized.

When a record ID is selected, a tooltip shows which accounts are 
assigned to that record ID.
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Open the View menu and select Columns to specify the desired columns.

Click on the Calculate table  icon or open the Edit menu and select Cal-
culate/Main table to start the calculation.

You can open a detailed view of any element (ID) in the main table. You can 
view details on the database source and on the record ID, user or station, 
depending on your basis of calculation. Each time a main table is calculated, 
a table of periods is generated automatically. This lets you open detailed 
views of usage, calls, and so forth for each selected ID, based on periods. 
The following is an example of a table of periods, created for “Elsevier Sci-
ence electronic journal” (first row), with a periodicity of months, from January 
2006 to June 2006:
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Select Cross table to have advanced calculations performed. You can pair 
the active basis of calculation (in this example, records IDs) with your choice 
of the following criteria:
• Periods
• Users
• Stations

You can choose from the following calculations for these criteria:

To calculate a cross table, open the Edit menu and select Calculate/Cross 
table or right-click on the main table and select Calculate/Cross table from 
the shortcut menu. 
In this example, the period from May to June 2006 has been selected. The 
following cross table was calculated on the basis of this data (record ID/
period/usage):

This table shows that usage of the “Elsevier Science electronic journal” in 
those two months accounted for 23.65% of all HAN account usage in that pe-
riod. Breaking this data down we see that 20.09% of the total usage occurred 
in May 2006, and 3.57% in June 2006.
To generate a report containing these results, open the File menu and select 
Create report or right-click and select Create report from the shortcut menu. 
Select the desired format and save the report. In this example, a HTML file 
is saved.
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Reports are automatically stored under \apache2\hh\han\sta-
tis\reports.

The HAN Statistics program can also display the main table data in the form 
of a graph. 
To view a graph, click on the “Graph” icon 
and select the desired values:

In this example, Total calls is selected. To 
keep the graph to a manageable size, only 
those e-journals are selected that were 
called at least 20 times in June 2006. 

The resulting graph appears as follows: 
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You also have the option of saving the active settings (i.e., your selection of 
record IDs, users and stations or Meta-IDs) as a View.
To do this, open the Edit menu, select View/New and enter a name for the 
View in the dialog. You can add and edit advanced options for the View as 
well.

The advantage of a View is that you can use your settings to calculate the 
latest data at any time.

You can use wildcards in defining the desired record IDs, users 
and stations. The View will always show the latest values for the 
selected IDs.

Example: You could create user IDs based on the departments in the com-
pany, and define employee IDs starting with “E,” and guest IDs starting with 
“G.” 

Important: The additional data is added to existing settings (record ID, etc.). 
If you want to select only those IDs that are stored in the additional fields, you 
need to deselect all sections in the main table first (on the left-hand side of 
the window).
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7.2   Concurrent Use
Unlike the main table, the concurrent use table lets you collect data on si-
multaneous usage of HAN resources. This can be useful in determining the 
number of licenses you should acquire for a given e-journal. 
Run the HAN Statistics program and select “Concurrent use” as the table 
type.

The options in the sidebar for defining the basis for calculation are largely 
identical to those available in the main table, and thus are not discussed 
here. 
The table pane shows the following columns:
• Record ID: For concurrent use tables, the record IDs is always used for 

the basis of calculation.
• Licenses: Optional value; the number of licenses allocated by HAN. 
• Max: Highest number of simultaneous usage instances.
• Days: Number of days on which the maximum concurrent use was 

reached.
• Duration: The longest period of concurrent use.

The five next lower values after “Max” are shown as well, to help you dis-
tinguish exceptional values that could skew apparent trends. The following 
spreadsheet is based on the data described in section 7.1, this time showing 
the concurrent use statistics for the month of June 2006.
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This table shows that there were five times on one day when “Elsevier Sci-
ence electronic journal” was in concurrent use for a period of almost 3.5 min-
utes. It can likewise be seen that this concurrent use was not an exceptional 
occurrence, as the following peak shows concurrent use four times on two 
days, for a total of more than 10 minutes.

7.3   Document Types
The Document Types table shows the usage of HAN resources in accor-
dance with criteria used by web-counter programs. For example, you can 
view the number of times PDF files have been called. 
The following must be configured to enable use of this feature:
• Document types must be defined (see section 3.4, HAN Administra-

tion).
• URL patterns must be defined for the document types (see sections 3.4, 

HAN Administration and 5.1, Accounts).

Document types group the calls of URLs that match the specified 
URL pattern. You can define any number of URL patterns for each 
document type.

This usage can then be calculated in a document-type table in HAN Statis-
tics. 

Run the HAN Statistics program and select Document-type Table as the 
table type.

The options in the sidebar for defining the basis for calculation are largely 
identical to those available in the main table, and thus are not discussed 
here. You can select Minimum or Maximum downloaded bytes to define 
filter criteria for the document types to be included in the calculation. 
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The following example uses the PDF document type: 
All calls of PDF documents are grouped under the PDF document type (URL 
pattern: *.pdf). This means all instances in which PDF documents were called 
are included in the statistics, regardless of the resource used to locate the 
document. 

In our example, a total of 2665 PDF documents were called in the month of 
June 2006. All documents together have a total data volume of approximately 
780 MB. The average data transfer volume was about 274 KB per call. (To 
simplify calculations, 1 KB is defined as 1000 bytes in this example.)
You can also perform further calculations by selecting Table of Users, Re-
cord IDs or Stations as described in section 7.1., Total Usage. 

Select “Database source” for detailed information on the effective usage of 
the PDF documents. 

The “Database source” table shows details on the use of PDF documents. 
For example, “SerSol” was used on 1 July 2006 by the user called “E1815U” 
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at a station with the IP address 83.31.226.40 from 00:34:27 hours (half-past 
midnight) to 01:22:00 hours. A total of approximately 2.3 MB was transferred, 
as shown in the “Bytes transferred” column (2,387,527 bytes). The “Data re-
cord attribute” column shows (/PDF:28,1654538) that PDF was the only type 
of document type transferred. This column shows the following data:
/<document type>:<number of documents>,<size in bytes>

Data on calls for other types of documents can be logged at the 
same time. If more than one document type has been called, 
the “Data record attributes” column shows the different docu-
ments types as follows (example): /GIF:34,123637/JPG:1,8677/
PDF:2,569073.

In this example, user “E1815U” called 28 PDF documents, with a total vol-
ume of approximately 1.6 MB, while using the “SerSol” HAN account.

The next step in this example is to determine which users loaded particularly 
large PDF documents. To do this, the Minimum downloaded bytes setting 
is selected in the shortcut menu and set to 30,000,000 bytes (~30 MB).

After calculation, the following spreadsheet is opened:
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This table shows that a total of 827 PDF documents with a volume of more 
than 30 MB (each) were called. 

The Database source detail shows that the “Elsevier Science electronic 
journal” magazine was called five times by the “Uni Library” user, which is 
actually a grouping of all users located in the library. In each call, at least one 
PDF with at least 30 MB was loaded. On 1 June 2006, the user at IP address 
194.29.133.41 called 168 PDFs for a total data transfer of some 55 MB, be-
tween 10:18 and 11:53 a.m. (see the first row).

Further details can be analyzed in the Table of Users, Record IDs or Sta-
tions. 
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8   HAN Components and Database 
Maintenance

8.1   Trace Monitor
The Trace Monitor is a diagnostic tool for tracking internal HAN processes 
such as checking user privileges, processing URLs, and so forth. 

Trace Monitor can output only information that was generated in the 
active session; in other words, in the same context in which Trace 
Monitor is running. To view information on the Apache service and 
the associated HAN modules in an RDP session, Trace Monitor 
must be launched for console messages.

8.2   Database Browser
The Database Browser gives you a direct view of the HAN log files. The first 
dialog page (HAN Details) shows raw data (each request logged) and the 
HAN Sequential dialog page shows summarized data (all calls made in a 
HAN session added together). Internal HAN events and EJL system events 
are shown on the Events dialog page.

8.3   LDAP Settings
In the configuration program for LDAP settings, you can define parameters 
for LDAP authentication in HAN. Your settings are stored in the %HANHome%\
bin\hhenv.cfg configuration file.
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Scheme for setting up LDAP in a Windows 2003 ADS interface:
Enter the data relating to the LDAP server you wish to use:
• Server = Name of the LDAP server
• Host name = Distinguished name of the directory in which users are 

stored
• User = User name for login on the LDAP server 
• Password = for login on the LDAP server

Click on LDAP default to choose one of two group schemes: 1) Microsoft 
LDAP server, or 2) Netscape LDAP server. Select the LDAP scheme from 
the defaults. If your LDAP scheme is different, you need to enter the follow-
ing values:
• User attribute = This value is used to depict the user name in the cor-

responding user DN.
• Group attribute = Name of the attribute
• Group value = Indicates whether this is a group or not
• Members = Attribute in which the members are defined

If your LDAP server supports communication over SSL, you can configure 
HAN to address the LDAP interface only with encryption. Example of an 
LDAP configuration (domain controller name: DC01; domain: library.local, 
Windows 2003 domain):
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8.4   Database Maintenance in the Statistics 
Program
HAN has two databases for data logging. The first, hanprot.dbf, logs all 
requests to providers of online content. In HTTP communication, each indi-
vidual element of a web page can require a separate request, which means 
loading one page can add a large number of requests to this log. This is why 
HAN uses a different database, hanprotd.dbf, for statistical analyses. The 
data in the the first database is added and stored based on user sessions. 

Both databases are stored in the %HANHome%\prot directory.

In the Statistics program, you can have data collated automatically when the 
program opens (see section 311, Statistics Program), or manually. After cal-
culation of data in the sequential database, the raw data is no longer relevant 
for statistical analysis.

Collating Databases Manually
Run the Statistics program, open the Edit menu and select Update data-
base.

Alternatively, you can have the database rewritten. The raw data in 
the hanprot.dbf database forms the basis for rewriting the sequen-
tial database.

In this case, the existing sequential database is deleted.

Delete Data Records
Due to the complexity of some web pages, the volume of raw data can grow 
rapidly, even to more than 10 GB, in a short space of time. We recommend 
checking your database at regular intervals and using the Delete data re-
cords function to delete any records you no longer need.

Data is not lost when you delete records from the data base. Re-
cords selected for deletion are stored elsewhere in a compressed 
file (ZIP).
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To run the wizard for deleting data records, open the Edit menu in HAN Sta-
tistics and select Delete data records. 

Depending on your selection, you may be prompted to enter a date, to have 
all data records written prior to that date deleted. Alternatively, you may 
choose to have all data records deleted. 

Data records are copied before they are zipped and removed from 
the database. Make sure you have enough space on the hard disk 
available for this operation.

You have the option of specifying a directory for storing the temporary files. 
To do this, open the nmstatis.cfg in the %HANHome%\Statis directory 
and enter the desired directory name for ZipTempPath in the “HAN” section:
[HAN]
ZipTempPath=<path	to	temp	directory>
If this entry has been commented out by a semi-colon (;ZipTempPath=), 
delete the semi-colon. 

Loading Deleted Data Records
Deleted data records can be loaded from the compressed file at any time. To 
run the wizard for loading deleted data records, open the Edit menu in HAN 
Statistics and select Load deleted data records. 

The database has to be opened exclusively (e.g., in only one 
instance) to perform any actions such as deleting or loading 
data records. This means the Apache service must be stopped, 
and HAN functionalities are not available during this period.

To avoid loss of data, we strongly recommend using the following procedure 
for deleting data records:

Shut down the Apache service. 
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Save your databases, as well as the “hanprotd.cdx” index file (ideally as com-
pressed files).

Save the hanprot.dbf file (ideally as a compressed file). 

Run the Delete data records function. 

Start the Apache service once the files marked for deletion have been com-
pressed and stored. 

Optional: delete the backup copy of the “hanprot.dbf” from the temp directo-
ry. If you have enough disk space, it might be a good idea to keep the backup 
copy of the sequential database, since it can be used to restore statistical 
data if necessary.
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9.1   Authentication Services and their Modules

Authentication service Module

NT login auth_nt.dll

IP address/host name check auth_ip.dll

LDAP login auth_ldap.dll

ADS login auth_ads.dll

NT4 login auth_ntads.dll

NetMan login auth_netman.dll

PICA login auth_lbs.dll (LBS system)

ODBC interface to existing data-
bases auth_odbc.dll

SISIS auth_sisis.dll

Authentication Modules and Associated Parameters
NT Login 
Authentication is performed on the default domain.

Module: auth_nt.dll
Module: auth_ntads.dll

Parameter:

DefaultDomain Default domain; applied when the user does not enter a  
  domain at logon.

IP Address/Host Name Check
Authentication is based on the client’s IP address and/or host name

Module:  auth_ip.dll

Parameter:

CFGFile   Path to the configuration file, which contains a  list of  
  permitted/excluded IP addesses and/or host names

Values for authentication are processed on the the IP Ranges/Host Names 
page and stored in a CFG file.
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LDAP Login
Authentication is performed over an LDAP interface.

Module:  auth_ldap.dll

Parameter:

CFGFile  Path to configuration file with LDAP values

Values are configured using the HAN-LDAP Settings program. The following 
settings must be configured

Server   Name of the LDAP erverr

Host name Distinguished name of the directory in which users are  
  stored

User  User name for login on the LDAP server 

Password  Password for login on the LDAP server

UserAttribute Attribute with which the user is displayed in the DN

GroupAttribute Name of the attribute

GroupValue Value that defines whether the user is a group

Members  Attribute in which the members are defined

ADS Login
Authentication is performed over an Active Directory System (ADS). 

Module:  auth_ads.dll

Parameter:

Object  For ADS:  LDAP://HostName[:PortNumber][/Distin-  
   guishedName]
  For NT4: WinNT:[//DomainName[/ObjectName[,class-  
   Name]]] 
   or
   WinNT:[//ComputerName,computer]

NetMan Login
Authentication is performed based on NetMan accounts

Module:  auth_netman.dll

Parameter:  

NMHome  NetMan directory
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PICA Login (LBS system)
Authentication is performed based on the PICA database

Module:  auth_lbs.dll

Parameters:

DSN  System data source name for PICA database 

DBUser  Database user (must have “read” permission in the  
  database) 

DBPasswd Password for reading the database

Library  Internal library number (iln).  Access is limited to users  
  of this library

Database Login
Authentication can be performed for any ODBC-compatible database

Module:  auth_odbc.dll

Parameter:

DSN  System data source name for database 

DBUser  Database user (must have “read” permission in the  
  database) 

DBPasswd Password for reading the database

TableName Table in which the authentication information is stored

UserField  Column containing login names

PasswdField Column containing the user’s login password

SISIS Login
Authentication is performed based on SISIS database

Module: auth_sisis.dll

Parameters:

DSN  System data source name for SISIS database 

DBUser  Database user (must have “read” permission in the  
  database) 

DBPasswd Password for reading the database
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<Variable 1>

9.2   HAN XML Tags

Designation   HAN account property
active   Account is active or has been deactivated

description  Description

eissn   eISSN

expireDate  “Valid until” date

ezbid   EJL ID

group   Group membership

inactiveFile  HTML page for notification if account has  
   been deactivated 

license   License name

licenseCount  Number of licenses

licenseID   Internal license designation

linkID   Link ID (name of account)

maskaradeIP  Masking IP address

periods   Licensing periods

protocol   Data logging active for this account (yes/no)

protocolID  Record ID

publisher   Publisher

remarks   Comments

right   Access privileges ID (“Permit ID”)

rootURL   Starting URL of the account

serverName  Starting server of the account

source   Source

subject   Subject

titel   Title of the e-journals

zdbno   ZDB number
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